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1. Introduction 

SeaStar is supporting software for the DST tilt Data Storage Tag. SeaStar can run 
under versions newer than Win 2000. This manual takes you step-by-step through the 
program installation, hardware connections and use of the SeaStar Program. New 
updates of SeaStar will be available for free download at: 
http://www.star-oddi.com/Online-Support/Software-updates/. 
 
Please note that the downloaded file has to be installed into the existing SeaStar 
folder. The update alone is not a complete program and therefore will not work like 
that. Follow the instructions on the update website for correct installation. 
 
This manual guides the users of DST tilt through the operation of the recorder. 
Setting the operating parameters as well as data retrieval requires access to a PC 
computer with a standard RS-232C serial interface or USB. 
 
DST tilt is a compact microprocessor-controlled tilt, temperature and depth recorder 
with electronics housed in a waterproof ceramic housing. 
 
The sensors are located as shown on the diagram below. 
 
 
 
 

 
 

Figure 1.1 DST tilt Sensors 

It is extremely important that the area where the pressure sensor is located is kept 
free, to allow free flow of water/liquid to the temperature and pressure sensors. Please 
note that the pressure sensor membrane is fragile, and objects should not be pressed 
against it, as it might cause damage. 
  

Tilt Pressure (depth) sensor 

Temperature sensor 
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1.1 Install 

To download SeaStar visit www.star-oddi.com/downloads. To install the program, 
follow the automatic InstallShield Wizard. 
 
Follow the instructions on the screen. You will be prompted for a directory name for 
your SeaStar program. 
 
Type in your product key. Please keep the product key in a safe location as you may 
need it for future use. The product key works for multiple computers on the same 
network. 

1.2 Uninstall 

To uninstall the program, do the following: 
 

1. Click on the Start button in Windows. 
2. Go to Settings and Control Panel. 
3. Choose Add/Remove Programs. 
4. Choose SeaStar  
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2. Preparation 

This chapter describes preparations that should be carried out before connecting to 
the recorder. 
 
Start SeaStar and the following window appears: 

Figure 2.1 SeaStar Main Window 

If you are starting the software for the first time, you will be asked if you want the 
Connection Wizard to open automatically each time you start SeaStar. If you change 
your mind you can always change the settings under Settings-Options-Startup. 

2.1 Select Recorder Type 

SeaStar is compatible with other Star-Oddi instruments. A recorder type must be 
selected before connecting to the recorder. The default setting in the software is set 
to Starmon mini as a recorder type. Change the recorder type to DST tilt by doing 
the following: 
 

1. Choose the File menu and the New Recorder Type command.  
2. Select DST tilt as a recorder type. 
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Figure 2.2 Select DST tilt as Recorder Type 

Before connecting to the recorder, it is important that the clock on the PC computer is 
correct. This is important since the recorder automatically downloads the PC clock 
settings. 

2.2 Configuration of the Communication Port 

It is necessary to define which USB or serial port on your PC computer you will use 
for connecting the Communication Box. 

Using the USB Serial Converter 

If you are using the USB serial converter you will need to download and install the 
driver from www.star-oddi.com/downloads. 
 
The easiest way is to use the Connection Wizard. When opening the software the 
following window appears: 

Figure 2.3 Connection Wizard 
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Connect the USB cable and the selected port will appear in the wizard pop-up 
window (see figure 2.3). 
 
The serial port can also be defined manually in the following way: 
 

1. Choose the Communication command in the Settings menu.  
The Communication definition dialog box appears. 

2. Select a serial port for communications. 
3. Choose the OK button. 

Figure 2.4 Communication Port Configuration 

After you plug in the USB cable you will see a new communication port in your device 
manager, called Prolific USB-to-Serial Comm Port. Make sure that the port is 
enabled and select the appropriate port in SeaStar. 

Figure 2.5 USB Communication Port in Device Manager 
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Using the Serial Port 

To check which communication ports are available on your computer, open your 
Device Manager. On Windows XP you can do it following way: Control panel > 
system > hardware > device manager. 
 
Under Ports you can view all available ports. Make sure that the port you are intending 
to use is enabled: right-click on the appropriate port and select properties. Under 
Device usage it should state use this device (enable). 

Figure 2.6 Enable Communication Port 
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3. Communication Box 

This chapter provides details concerning the Communication Box and how to place 
recorder in the box prior to connection. 

3.1 Communication Box 

The DST Communication Box is a PC-RS-232C compatible communication interface, 
specially designed to communicate with DST recorders wirelessly via RF (radio 
frequency). A USB serial converter plug can optionally be used with the 
Communication Box. 
 
The Communication Box has three diodes: 
 

1. Red  shows that power is fed from the power supply to the Communication 
Box. 

2. Yellow  shows that SeaStar has made connection with the box and that 
correct COM port has been selected. 

3. Green  shows that recorder is in correct position for seeking connection. 
 
Connect the serial cable between the serial port of the computer and the 
Communication Box. Plug the power supply connection to a power-socket. The 
voltage from the power supply should be set to 9V, although there is no damage to 
use up to 20V. Before inserting the power plug into the box, it is important to note that 
the polarity should be:  
 
 
 
 
The polarity is usually shown where the arrows meet on the power plug, and the 
power supply. After the power supply has been connected to the Communication Box, 
the red light should be on. After SeaStar has been started, the yellow light should be 
on (if correct COM port is selected). 
 
The box will power the recorder while communicating with the PC. In case the battery 
is dead, the PC and interface are still able to connect to the recorder and retrieve 
data. 

3.2 Connection Point 

In order to get the green light, the red and the yellow light must be on.  
The recorder is inserted into the hole of the box as shown in the figure below: 
  

-(O+  (minus on the outside and the plus on the inside) 
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Figure 3.1 Inserting Recorder into the Communication Box 

If the recorder has been recording in the waters, then please wipe it dry before 
inserting it into the box. The spherical end of the recorder faces down and flat end 
faces up. 
 
When the green light is on, communication can be established with the software. 
 
If the recorder fails to connect, please refer to the Troubleshooter. 

3.3 COM Connection 

Figure 3.2 Communication Definition 

  

Communication Box 

DST tilt 
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Choose Settings-Communication-Serial Ports to display available ports (see figure 
3.2). Com ports up to COM255 can be selected. 

3.4 Connection Wizard 

Figure 3.3 Connection Wizard 

Choose Wizards- Connection Wizard. Connect the USB cable and the selected 
port will appear in the wizard pop-up window (see figure 3.3). 
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4. DST tilt 

4.1 General Description 

The DST tilt measures additionally to temperature and depth, tilt in 3-D three 
directions (with reference to the earth  gravity). The diagram below shows the three 
axis; X, Y and Z. 
 

 

Figure 4.1 DST tilt 

Because of the three axis the DST tilt can be placed horizontally or vertically. The DST 
has a mark on the end. When sitting horizontally on a flat plane, and with the mark on 
the DST pointing straight up, the axis should give: 
 

X = 0° 
Y = 0° 
Z = 90° 

 
The tilt accuracy is better than +/-3° and applies to a tilt range of +/-90° for each axis. 
The optimal accuracy for X and Y axis is when recorder is mounted horizontally but 
optimal for Z axis when placed vertically. 
 
When the recorder is placed horizontally on a plane or the tag holder, and holes at the 
nose have equal distance from the plane, then both the Pitch axis and the Roll axis are 
centred at ca. 0° angle while Z shows ca. 90°. tilt om 
defined text on the housing should face up when placed horizontally. When used for 
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fish tagging, the tag holder is required. When the Adjustable housing is used, the 
recorder is fixed inside the housing with a clamp, and the mark on housing face 
directly up if placed horizontally. 

Fig. 4.2 Adjustable Housing with DST tilt inside 

The tilt angles are referenced to the local horizontal plane, i.e., the plane perpendicular 
to the earth's gravitational vector. 
 
Pitch is defined as the angle between the 
horizontal plane (positive for nose up). Roll is defined as the angle about the 
longitudinal axis between the local horizontal plane and the actual recorder orientation 
(positive for right wing down). 
 
In case the recorder is placed horizontally the following applies: 
If the recorder is rolled to the portside, i.e. to the left (seen from the end where the 
pressure sensor is) of the recorder, the Roll measurements are negative down to -90°. 
If rolled to the starboard (to the right), the Roll measurements become positive up to 
+90°C. 
 
The Pitch axis 
negatively when tilting down. 
 
It should be emphasized that the pitch and roll angles that are calculated in SeaStar 
are references to the horizontal plane and will thus not show the actual body rotation 
of the logger unless transferred to PatternFinder where you can see the rotation of 
the logger in animated form. 
 
One thing that should also be considered is that the tilt sensor is fundamentally an 
accelerometer and fast movements can give rise to erroneous tilt measurements. 

4.2 Hands on Description 

Before putting the recorder in real situation, it is recommended to the user to do a 
short test on different angles, to better figure out how the tilt sensors operate. For that 

which angles the recorder is placed at each time. It is recommended to let the 
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recorder take measurements in its initial position on the subject, as to have the 
reference from the starting point. 

4.3 Acceleration limit 

Acceleration limit is an attempt to minimize the effect of acceleration exceeding the 
earth s gravitation. 
 
The Tilt sensors are basically accelerometers and the tilt values are derived from the 
acceleration measurements, thus if the sensor experiences acceleration beyond the 
gravitational acceleration it can lead to extreme/erroneous tilt values. Sudden jerky 
movements, knocks and bumps and much vibration can have this effect. 
 

The nominal acceleration vector is used for comparison. For better readability the 
nominal vector is displayed with a milli prefix as an integer. 
The acceleration limit values are delta values 0-999. The default value is 100, i.e. 10% 
of earths nominal gravitation. 
Thus using the default value, if the acceleration vector exceeds +-1100 then X,Y and 
Z acceleration values are exchanged with previously measured values. 
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5. Using DST tilt - Tutorial 

This chapter guides users in 8 quick steps through the process of utilizing SeaStar to 
set up DST tilt prior to recording and data retrieval. 

5.1 DST tilt Set Up 

Step 1 - Start Program 

Start SeaStar as described in chapter 1. Remember to carry out the software 
preparation outlined in chapter 2. 

Step 2 - Connect 

Connect the Communication Box as described in chapter 3. Insert DST tilt into the 
hole in the box, and twist the recorder until the green light illuminates on the box. 

Step 3 - Connect to the Recorder 

Insert the DST into the box, the selected com port will turn green in the Connection 
Wizard window. 

Figure 5.1 Connection Wizard 

You can either click once on the selected port and select Next or double-click on the 
port. If you are not using the wizard choose the Recorder menu and the Connect 
command. 
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The window in figure 5.2 appears. 

Figure 5.2 Connecting and Retrieving 

Once the connection has been established, a window appears with information on the 
). 

Figure 5.3 Connecting to the Recorder 

Press OK. The Recorder is now on-line, as indicated at the bottom of the SeaStar 
window. 
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If you have selected to use the Connection Wizard, the following window appears: 

Figure 5.4 Connection Wizard 

SeaStar checks which version of firmware is in the recorder. If the software does not 
recognize the firmware the user will be asked to update SeaStar as there might be a 
new functionality in the firmware which SeaStar does not support. 

Connection time Registration  
Each time SeaStar connects to a Recorder, the PC time and recorder time is 
registered to a binary file, with a CLK extension. This information is also saved to a text 
file with the extension CCT.  
Another text file is created with the extension CCD, containing various information, for 
example on previous connection and time comparisons, depending on the status of 
recorder.  
If a previous CCT file exists and the recorder was in sleep or slumber mode, a PC vs. 
recorder clock comparison is calculated, indicating difference in seconds and ppm.  
If the recorder was in measurement mode, then a drift calculation is performed, based 
upon PC-  
The RIT file contains partly the same information as the CCD file.  
Upon retrieving date from a recorder and converting the data, the last measurement 
retrieved time and the next scheduled measurement time is compared to the PC time. 
The results are added to the CCD file and the MIT file.  
Note: If the retrieved number of data does not match the last measured number of 
data, erroneous results are to be expected. 
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Step 4 - Set New Measurement Parameters 

(If the recorder has already been set up to record data and you want to retrieve data, 
go directly to step 6). 
 
 
Select Program and start recorder in the wizard and select which interval, single or 
multiple, you want to use (see figure 5.5). 

Figure 5.5 Intervals 

If you are not using the wizard choose the Edit menu and the New Measurement 
Sequence Definition command. The window shown in figure 5.6 appears. 

Figure 5.6 Measurement Sequence Definition 

Select the start time of recordings (date-month-year, hours-minutes). The start time 
of the new measurement sequence must be set at a minimum of three minutes in 
advance. Set the sampling interval (hours-minutes-seconds). 
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With default settings, Temp-Depth (TD) and Tilt will be recorded at each sampling 
(TD-Tilt normal). The user has the option to select either TD or Tilt as a primary sensor. 
The objective with this feature is to save memory size, increase recording period, and 
get more data on the sensor that is of more interest (primary sensor). In this case, a 
secondary counter can be defined, which can only be odd numbers. If for example Tilt 
is selected as a primary sensor, and the number 3 is defined as a secondary counter, 
then TD will only be recorded every third time when Tilt is recorded, and the majority 
of the memory is used for Tilt recordings. If Tilt is set as primary and secondary 
counter to 0, then it is only making Tilt recordings, even though the first recording is 
always a Tilt-TD measurement. 
 
If the Use unfiltered Acc option is enabled the absolute tilt measurement is recorded, 
i.e. there is no average behind the measurement, it only consists of one measurement. 
 
If the user wants to program several recorders with the same sampling interval and 
start time, it is recommended to select Multi mode. By choosing Multi mode, the 
settings are fixed; giving each recorder connected to thereafter, the same settings. 
The recorders connected to, following the first recorder, automatically get the same 
settings as the first recorder. This saves time in the programming process. The multi 
mode can be deactivated by clicking Cancel when connecting to the recorder (see 
figure 5.7). 

Figure 5.7 Multi Start Mode 

For programming more than one sampling interval, please refer to chapter 9.Multiple 
Intervals. 
 
The three buttons Use Template, Use Sequence, and Previous are not commonly 
used, but can be handy when wanting to use a previously programmed sequence. To 
read more about templates see chapter 8.13. 
 
After the settings have been selected, press the OK button. 

Burst measurements in DST tilt 
Users of DST tilt have the option of burst measurements. With burst measurements 
the logger will take 5 measurements every second, i.e., every 500 millisecond. 
 
To activate the burst measurements, the user must select Burst 5/sec ON (see figure 
5.6). When this option is enabled the Use unfiltered Acc option also becomes 
enabled. Burst measurements are also available for multiple intervals. For more 
information see chapter 9. 
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Step 5 - Start a New Measurement Sequence 

If you are using the wizard, the software will automatically start the new measurement 
sequence (start recording) and disconnect the logger. If you are not using the wizard 
choose the Recorder menu and Start New Measurement Sequence command. The 
window in figure 5.8 appears. 

Figure 5.8 Start New Measurement Sequence 

Once the new measurement sequence has been downloaded into the recorder, a 
window appears on the screen in order to verify the settings (see figure 5.9). 

Figure 5.9 Start New Measurement Sequence 

Press OK and the recorder will be in Measurement Mode. 
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NMS Calculation  
Upon setting up a NMS the estimated measurement sequence is calculated and 
memory and battery energy usage predicted. The results are written to a text file, 
bearing the recorder name with a NMS extension. If a recorder has not been selected 
then the file bears the recorder type name, still the NMS extension. 
The file is placed in the SeaStar\NMS directory. 
An example of the *.NMS file is shown in fig. 5.10. 

Figure 5.10 Results from NMS Calculation 

When starting the recorder in a NMS, the *.RDT file shows the sequence settings, 
plus information on the sequence time duration and battery usage (same as in the 
*NMS file). 

Step 6 - Retrieve Data 

When connecting to a logger after a measurement period, the following window 
appears: 

Figure 5.11 Retrieve recorder data 

Click Yes if you wish to retrieve the data, click No if you would like to retrieve it later. 
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If you want the software to automatically retrieve data upon connection, check the 
Remember this setting option. 
 
Select Retrieve Recorder Data in the wizard or choose the Recorder menu and the 
Retrieve Data command. The following window appears: 

Figure 5.12 Retrieve Data from Recorder 

The window in figure 5.12 shows the data retrieval progress in bytes, time elapsed 
and number of packs received. 
 
Data will be uploaded from the recorder and presented in graphical and tabular form. 
With default settings, SeaStar automatically creates a sub-directory in the Seastar 
directory, named DST tilt. In the DST tilt directory, a directory named after the 

nnnn) is created. All files related to the recorder are 
automatically saved in the serial number directory. The default data directory can be 
viewed in the Settings menu, and Directories. The user has the option to define a 
new data directory path if desired. 
 
The data is retrieved in a non-destructive manner. This means that you can repeatedly 
read the data without erasing it from the memory. Each time data is retrieved, a new 
file will automatically be created. The name of the data file consists of the 
measurement sequence number and the serial number of the recorder. The recorder 
cannot be loaded with new settings if it contains data that has not been retrieved. This 
is a safety feature which prevents data from being accidentally lost. New recordings 
overwrite previous recordings that have been retrieved. 
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Once the data has been retrieved the following window appears: 

Figure 5.13 Recorder wizard 

If you wish to start a new measurement sequence you can either program the logger 
with a new measurement sequence by selecting Program and start recorder or 
Restart recorder with the same sampling interval. 

Step 7 - Disconnect 

After the recorder has been set up for measuring, it should be removed from the 
Communication Box. If the recorder is not put in measurement mode, it will 
automatically go into sleep mode when removed from the box. 
If you simply remove the tag SeaStar will still have the recorder in on-line mode in the 

selecting another recorder or using certain options. Select 
Disconnect Recorder in the wizard or Recorder > Disconnect to go into off-line 
mode. 

Step 8 - View Data 

If data is retrieved from the recorder, a new file will automatically be created and 
opened in graphical and tabular form. To open existing data files on the computer, 
choose the File menu, Select Recorder command, and then the Select 
Measurement command. When a data file has been opened, a new window appears 
with the data shown as a chart and a table. The next chapter will describe in detail 
how to view and process data. 
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6. View Data 

This chapter describes how to open a data file and the options available in SeaStar 
for viewing the data. 

6.1 Open Data 

To open an existing data file that has already been retrieved, do the following: 
 

1. Choose the File menu and the Select Recorder command. When a recorder 
has been selected, its serial number will be displayed in the blue top bar of the 
software. 

2. Select the data file by choosing the File menu and the Select Measurement 
command. 

 
The name of the data file consists of the measurement sequence number (number of 
times the recorder has been set up to measure) plus the serial number of the recorder. 

SeaStar 
window. When the data file (.mid) has been selected, the chart and data tables are 
opened. The following figure shows a chart and data table which have been opened: 

Figure 6.1 Chart and Data Tables of an open File 
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Import 

Data files from other recorders than DST can be imported into SeaStar and viewed as 
charts and tables. The imported file must be a text file with the extension DAT, and 

 See more about data files and headers 
in the Appendix. 

Buttons 

When the chart is opened, buttons related to the chart are displayed. 
 

 

Active Series List 
This button can be useful when working with a multi-sensor recorder, in order to 
select which parameters to display in the chart. For example, when working with a 
chart displaying temperature and depth recordings, the user can hide the depth or the 
temperature line in the graph. Click the button and the following window appears: 

Figure 6.2 Series list 

By selecting Only show active table columns only the selected series will be 
displayed in the chart table. 
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The table columns can also been changed manually by right-clicking on the table (see 
figure 6.3). 

Figure 6.3 Table 

 

Horizontal/Vertical Gridlines 
These two buttons give the option of hiding/displaying the horizontal/vertical gridlines 
in the chart.  
 
A drop-down menu appears when clicking the horizontal gridlines button. 

Figure 6.4 horizontal gridlines 

Select the series gridline. 
 
A drop-down menu also appears when clicking the Vertical gridlines button 

Figure 6.5 vertical gridlines 

Select the minimum grid size. 
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Data Point Marker 
This button gives the option of displaying/hiding data points in the chart. 
 

 

Histogram 
The chart can be shown as histogram, displaying the distribution of values by 
percentage. 
 
Click the Histogram button and the following window appears: 

Figure 6.6 Histogram and data statistics 

Under Bin Settings there are two options, Default and User. Choose User to select 
the number of bins and the minimum and maximum values you wish to display. 
 
The Histogram can be printed out by clicking the Print button. 
 

 

Save Window Data 
Retrieved data is automatically saved, but if changes are made with the graph, for 
example with the time scale, the save button enables the user to save the graph (as a 
DAT file). 
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Print Chart 
The chart can be printed. Please see chapter 7 for more details. 
 

 

Zoom Out 

Click this button to zoom out the chart. 
 

 

Zoom In 

Click this button to zoom in on a previous view. 
 

 

Adjust Axis 

This button adjusts the axis in order to display all data within the zoomed timeline. 
 

 

Open file in PatternFinder 

Click this button to transfer data to PatternFinder 
 

 

Chart Edit 
By clicking this button, the following window appears: 
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Figure 6.7 Editing Chart 

This button gives several options regarding the look of the graph. The axis can be 

background, borders and gradient can be selected. - 
and gradient of the graph itself can be selected. 
to activate the features. The graph can be exported in formats as jpg, gif, bitmap, 
metafile, pdf, htm and svg. 
 

 

Templates 

that template. It is also possible to load a previously saved template. 
 

 Display table completely 

 Partial table display 

Hide table 

Using the Mouse 

Max and Min Values 
Click once on any line in the chart, and the maximum and minimum values for that line 
(sensor) are now shown. A straight vertical line should be visible in the graph (to the 
left). By clicking on this line and holding the left button on your mouse down, the line 
can be dragged through the chart and the data table will scroll along with the position 
of the line. 
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Zoom 
The chart can be zoomed in by holding down the left button of the mouse, and using 
the cursor to create a box to the right, around the desired area to zoom in on.  

Scroll the Chart 
The chart can be scrolled upward, downwards and to the sides, by holding down the 
right button of the mouse and moving the cursor in the desired direction.  

Go Back to Initial View 
To go back to the initial view of the chart, simply hold down the left button of the 
mouse and make a box to the left with the cursor. The position of the box on the chart 
is irrelevant. 

Change the Axis 
By double clicking on the X and Y-axis, the measurement time and temperature/depth 
range can be changed. 

Change the Title 
To change the title of the chart, double click on the title of the chart 

6.2 The View Menu 

When a recorder has been selected, the files in the View menu can be opened. 

Data Trend and Table 

This view is automatically selected when data is retrieved or a data file is opened. If 
the chart is closed, but a recorder has been selected, this command can be selected 
to view the chart. The software will open the latest chart that was viewed for that 
recorder. 

Acceleration 

Select View-Data Trend and Table-Acceleration to view the acceleration. 

The *.A90 file 

Tilt measurements are basically calculated from acceleration to +/-90° on all axis. 
Viewing the tilt values in a +/-180° system is more natural. The 180° can be arrived to 
via calculation and this is used in SeaStar. 
 

A90 can now be viewed in SeaStar, graphically and as a text file. The 90° tilt values 
for the three axis X,Y and Z are represented as well as the different values after 
acceleration limiting and boundary round off. 
An example of a *.A90 is shown in figure 6.8. 
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Figure 6.8 Tilt values in the +-90° system 

Recorder Information (RIT) 

This is a text file containing basic information about the recorder, serial number, 
production date, estimated battery life etc. 

Recorder Calibration Information (RCI) 

This text file contains information about the calibration constants of the recorder, 
calibration range of the parameters. The range is both showed as decimal values (DV) 
and unit values (UV). The survival depth of the recorder is also shown. 

Recorder Download Information (RDT) 

This text file contains information about the measurement sequence that was last 
downloaded into the recorder, including the start time, sampling interval and the 
measurement sequence number. 

Viewing Text Files  

Under <View\Text files> the user can select a text file, via a file browser, for viewing.  
This option is meant to give the (advanced) user a chance to view files that are not 
directly supported for viewing in SeaStar, but are a part of the SeaStar documentation 
system.  
The files that the file browser accepts must have the following extensions: 
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 TXT 
Frequently, users copy SeaStar data to text processors and spreadsheets, like 
Word and Excel, and later save the data as TXT files for viewing in other 
applications.  

 INI 
There are a number of INI files that SeaStar uses for store settings. These files 
are described in the Appendix und
the INI files family are the Template files.  

 DAD 
This is the original data file. It contains the raw data (in Ascii format) retrieved 
from recorder. The DAD together with the MID are converted to the DAT file. 
A word of warning: The DAD file should never be tempered with, as that might 
give cause to erroneous data conversion. 

 CCT 

clock data are stored in a <recorder name>.CCT file.  
 CCD 

time are compared to the last CCT, if found, and stored in <recorder 
name>.CCD file, <measurement sequence name>.CCD. 

 NMS 
Upon completion of a NMS editing session, estimation of memory and battery 
usage is calculated and the results placed in a NMS file, which is then 
displayed to the user. 

SNMS LOG File 

success or failure, a log file for each recorder type is placed in the SeaStar directory. 
The log file name, for example for DST milli, is DSTM.LOG, i.e. the same naming 
convention as for the type INI files. 
Each time a SNMS is performed then the appropriate LOG file is updated. 
The LOG file can be viewed \ .  
In addition to the LOG file, if an error occurs during the SNMS, the MDD file is 
created as a text file, with a description of what went wrong. This MDD file is 
displayed as a clear message for the user: 
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Figure 6.9 The MDD SMNS Error Message 

Usually the MDD file is a binary file, and the MDT is created from the MDD. If the 
SNMS is repeated successfully the MDD file is overwritten and the MDT file created. 

Measurement Data 

Measurement Download Definition (MDT) 
This text file contains information on data downloaded into the recorder for the 
measurement file being viewed, including the start time and sampling interval. 

Measurement Information (MIT) 
This text file contains information concerning the measurement upload time, start date, 
start time and number of measurements in the measurement data file. 

Conversion Information (CIT) 
This text file contains conversion information on the units and the data file format. 

Statistics in CIT 
The CIT has been enhanced with more detailed information on the converted data. 
 
As can been seen in figure 6.10, the statistical data, that has been tabulated, are split 
into two sections, the Unit values statistics and the Decimal value statistics. Values are 
given for each parameter. The file \Measurement 
Data\  
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Figure 6.10 Statistics in CIT File 

Out of Range (OOR) 
This text file lists all the measurements that were outside decimal value calibration 
range, as well as the unit value range. If correction has been performed according to 
the user definition, then the corrected values are show. See more in chapter 8.7 Out 
of Range. 

Binary Data (DAB) 
This file contains raw data of the measurements in the data file. Calibration files are 
not calculated into the data. 

View DAB Files as Trend 
When converting the DAD -> DAT the DAB file is created simultaneously.  

-4095. 
These values originate from the recorders 12 bit ADC (Analog to Digital Converter). 
It can be of interest to view the data in its native form, for example to spot 
saturation/out of range intervals. 
The DAB can be viewed graphically as a trend via: 

\Data Trend and Table\  
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Figure 6.11 DAB Trended 

SeaStar cannot view older DAB files, and will inform the user to that effect, if an 
attempt to view an older DAB file is performed. By reconverting the data, a viewable 
file is produced. 

Binary Pressure Temperature Corrected Data (BPD) 
Pressure measurement circuitries are calibrated against measurement errors due to 
temperature changes. 
 
Raw decimal values from the recorder can be seen in the DAB file. The first step in 
converting decimal values to unit values is the circuitry temperature correction. The 
result of this first correction can now be seen in a new file in SeaStar, *.BPD. The file 
contains the corrected decimal value and the difference between the original value 
and the corrected one. 
 
The file can be viewed graphically or as tabulated lists. 

Binary Pressure Temperature Corrected Data (BPD) 
Pressure measurement circuitries are calibrated against measurement errors due to 
temperature changes. 
 
Raw decimal values from the recorder can be seen in the DAB file. The first step in 
converting decimal values to unit values is the circuitry temperature correction. The 
result of this first correction can now be seen in a new file in SeaStar, *.BPD. The file 
contains the corrected decimal value and the difference between the original value 
and the corrected one. 
 
The file can be viewed graphically or as tabulated lists. 
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Converted Data (DAT) 
This is the text file for the converted data. The DAT file as well as the other text files 
can be opened in other programs (Excel, Notepad, Word etc.). 

Time Synchrone Data (TSD) and Rate of Change (ROC) 
If the TSD and/or ROC file creation has been enabled under the Settings menu, then 

 
 
You can find more in chapter 8.8 TSD and chapter 8.9 ROC. 
You can find more about files in the Appendix. 

SeaStar Log 

SeaStar stores events in the file <SeaStar.log>. The events are: 
 Recorder Connected 
 Retrieving data from a recorder 
 Uploading a measurement sequence to a recorder 
 Recorder disconnected. 

This file can be opened in SeaStar under <View/SeaStar Log> or by opening it with a 
text editor. 

Screenshots 

By pressing the Print Screen keyboard button while in the application a screenshot of 
the desktop is taken and stored in a subfolder, Screenshots. 
 
The user can name the screenshot file as can be seen in the following figure. 

Figure 6.12 Name the Screenshot 

The screenshots can be viewed in View-Screenshots or by browsing the screenshot 
folder, <\SeaStar\ScreenShots\>. 
 
The button also performs its normal operation which is to store the screenshot in the 
clipboard. 
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6.3 Opening Data in Excel 

When retrieving data, the SeaStar software automatically creates a text file with the 
data, called *.DAT. This text file can be opened in Excel and in other programs. 
 

 
 If this option is not disabled, the following is 

performed, for opening data in Excel: 
 

1. Excel is started. 
2.  
3. Excel comes  This is a three step process: 

a. No changes should be made in first step, so press the next button. 
b. Press the next button. 
c.  Press the finish button. 

4. You can now create the graph with columns B, C and D. 
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7. Printing 

All charts and text files can be printed from the SeaStar software. 

7.1 Charts 

Open the chart you want to print out and select File-Print on the menu bar. The 
following window appears: 

Figure 7.1 Print Preview 

Orientation 

The chart can be printed in either portrait or landscape format. 

Margins 

-scaled. The margins 
can be varied by either changing the numbers given for the left, right, top and bottom 
margins, or by moving the margin lines with the mouse by pressing and holding the left 
button as the lines are dragged. 

Move 

When the cursor is located on the chart, a hand becomes visible. By clicking on the 
chart and holding down the left button of the mouse, the chart can be moved around 
the page to a desired position.  
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Details 

The size of horizontal and vertical gridlines as well as the texts on the X and Y-axis can 
be re-scaled by using the scroll bar. The number of gridlines is increased when the 
bar is moved to the left. 
 
Another way of printing out a chart is opening the chart you want to print out and 
clicking the Print Chart button on the chart bar. 

7.2 Histogram 

To print out a histogram, open the chart which histogram you want to print out and 
click on the Histogram button on the chart bar. The following window appears: 

Figure 7.2 Histogram 

Click Print and the window in figure 7.3 appears: 
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Figure 7.3 Output Options 

To change the selected printer, click Setup and select another printer. 
 
To see a preview of the print out, select Preview under Report Destination and click 
OK (see figure 7.3 and 7.4). 

Figure 7.4 Report Preview 
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7.3 Files 

Activate the file you want to print out and select File-Print on the menu bar. The 
following window appears: 

Figure 7.5 Output Options 

The dialog window in figure 7.5 has the same functions as the one in figure 7.3. 
 
Note that as some of the files are very large, it is recommended to highlight the data 
you want to print out before printing. 

Figure 7.6 Report Preview 
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8. Settings 

This chapter describes the options in the Settings menu. These settings are 
automatically saved when exiting the program. 

8.1 Directories 

The path definition can be set as Default SeaStar path structure or User defined 
paths. Choose the Settings menu and the Directories command. A dialog box 
appears: 

Figure 8.1 Directory Path Definition 

Default SeaStar Path Structure 

By choosing DST tilt as a recorder type, SeaStar tilt

installed on the computer. Upon connection with DST tilt, another directory is 
tilt

of the recorder. 

directory. Each DST tilt recorder has its own data directory. 

User Defined Paths 

If this option is selected, the User definition data directory becomes active. The data 
path/directory can be defined by the user. For defining a path on the network, the 
particular drive must be mapped (under Windows Explorer) in order to browse for the 
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Browse First in User Directory 

With default off, the user is first directed to the path where SeaStar was installed, to 
look for the INI file. If this option is enabled, SeaStar will start looking for the INI file in 
the user-defined directory. More information on files and directories can be found in 
the Appendix. 

Create Recorder Directories 

This option is default on, and means that a recorder type and serial number directory 
is created for every recorder connected to. 

8.2 Preferences 

Units 

By choosing the Settings menu, the Preferences command, and Units, a dialog box 
appears: 

Figure 8.2 The Units Dialog Box 

Select Units 

The user defines whether degrees Celsius or Fahrenheit are used as a unit for 
temperature measurements. The pressure measurements can be displayed as 
pressure (bar), depth (m), fathom (fthm) or PSI. Number of decimals for the values can 
be selected. The tilt heading is default set to 4 point tilt (N-E-S-W) but also possible 
to increase it to 8 or 16 point tilt. 
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8.3 Data File Format 

By choosing the Settings menu, the Preferences command, and Data File Format, a 
dialog box appears: 

Figure 8.3 Data File Format Dialog Box 

Date Format 

The user defines whether the date should be shown as dd mm yy (day, month, year), 
or mm dd yy (month, day, year). 

Date Separation 

The user defines whether a dot, slash or dash should be used to separate the date. 

Time Separation 

The user defines whether a colon or a dot should be used for the time separation. 

Field Separation 

For the text files created, the user defines whether a tab or a space should be used to 
separate the fields. 

Date and Time Column Definition 

If data is to be exported to other programs, it is recommended that the date and time 
be joined in one column. 
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Select Decimal Point 

The user defines whether a comma or period is used for the values displayed in 
SeaStar and for text files that are created.  

8.4 Connection 

Choose the Settings menu and the Connection command. A dialog box appears: 

Figure 8.4 Connect and Retrieve Data Options 

Perform CRC Test when Retrieving RID 

The CRC test is a safety check performed by the software when retrieving Recorder 
Information Data (RID). If the CRC test is not successfully carried out, it means that 
some errors have occurred in the transfer of files or constants, between the recorder 
and the computer. If a CRC test failure occurs, the user is notified. This option is 
enabled by default but if disabled there is a risk of errors in the constants. 

Check Data Echo in SNMS 

Normally the Check Data Echo in SNMS and updating settings in Disconnect and 
Retrieve Data should be enabled (figure 8.5). In case of communication problems 
using a USB serial converter the user can try to disable this option, as it will bypass 
data echo checks, resulting in less restriction on communication protocol. 

If data is in the recorder then: 

If this option is enabled, data retrieval is done 
manually via the recorder wizard or by choosing the File menu, and Retrieve Data 
command. 
Automatic data retrieval upon connection: By enabling this option, the software will 
automatically check for data in the recorder upon connection and retrieve it. 
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Ask user whether to retrieve the data: By enabling this option, you will be asked 
whether you want to retrieve the data or not each time you connect to the logger. 

8.5 Retrieve Data 

Choose the Settings menu and the Retrieve Data command. A dialog box appears: 

Figure 8.5 Retrieve Data Options 

Retrieve Number of Data 

With default settings, the software retrieves the last measurement sequence recorded. 
 

By choosing the User defined number of data, the number of measurements 
retrieved from the recorder can be set. 
 
As the complexity of measurement intervals give incoherence in the calculation from 
measurement number to the number of data byte to retrieve, the user has the option to 
define number of bytes to retrieve. 
 
If for some reason or another it becomes necessary to retrieve data more than once or 
even several times, the previous DAD and MIT files are not overwritten before a 

the last DAD file.  
 
A backup number system is in use that marks the first retrieved file as number one, the 
second number two etc. The number sign #, is used to identify the backup up files. 
 
Thus if a data file has for example the name 25M1106.DAD then the backup file, that 
was the first retrieval, gets the name 1#25M1106.DAD, and the 25M1106.MIT file 
that is associated with the DAD file, is backed up as 1#25M1106.MIT.  
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8.6 View Data 

Choose the Settings menu and the View Data command. A dialog box appears: 

Figure 8.6 View Data 

Select View Data Trend after data retrieval/conversion to view the data right after 
data retrieval. 
 
Select View Data Trend after Measurement Sequence Selection to work with 
measurement data while offline. 
 
With all the options in SeaStar, the user may want to do a lot of reconverting 
(<File\Reconvert Data>) on data files after defining the preferences; changing units, 
data formats, OOR settings, TSD settings, ROC settings, offset settings and 
converting different sections of the data file, all of which result in numerous files. To 
ease the task of remembering settings and results and/or renaming and copying files, 
a backup system of reconverted files has been implemented. 
 
A reconvert number is now associated with each sequence. This number is saved in 

rt is implemented. A copy is 
made of the DAT, CIT, DAB, OOR, TSD and the ROC files with the reconvert number 
attached to the filename. 
Thus if a data file is for example named 5Q1024.DAT, then after the first reconvert, a 
copy of the DAT is named 1-5Q1024.DAT, and the same naming convention is 
applied to the other files. 
 
Each time data retrieval is performed, a subdirectory, which name is the sequence 

 CIT 
and OOR files is placed. -
files are placed in the sequence directory. The reconvert number system is optional, 
and the user can disable it in the reconvert menu. When the reconvert number system 
is in use, and when v
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8.7 Out Of Range 

If measurements are outside the calibrated range, they are less accurate. The out of 
range measurements (if any) are shown in the OOR file (View  Measurement Data  
Out Of Range Data). For example when depth measurements are outside the first 
calibration range (at very shallow depth or in air) the data may look strange and the 
user may want to set those data to 0. 
 
Choose the Settings menu, Out Of Range - UV and DV definition command. A 
dialog box appears: 

Figure 8.7 Set Ranges for the Parameters 

The Unit Values (UV) ranges can be set, eliminating all values that are outside the 
calibration range. 

Decimal Values 

Decimal Values (DV) are raw measurements, sometimes referred to as binary data. 
The decimal value is between 0 and 4095, which is the range for the 12 bit AD 
converter.  The user should not 
define the decimal value range, unless he has obtained these values for that particular 
recorder from Star-Oddi. 

Unit Values 

The decimal values are converted to Unit Values (UV), for example a decimal value of 
2000 could give 20°C. The user can select a specified range for the parameters. If 
unit values in the data are outside the measurement calibration range of the recorder, 
the user has the option to set a max and min range for these unit values. After 
selecting the unit value ranges and pressing the OK button, the following window 
appears: 
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Figure 8.8 Out Of Range (OOR) Correction 

-  If Unit Values (UV) ranges were specified, the user has 
two options: 
 

1. Last Value: Change the out of range measurements to the last value that was 
recorded before the out of range measurement was recorded. 

2. Max/Min UV-limits: Change the out of range value to the max/min unit value as 
specified earlier. In this case the software will know if the value is under the 
minimum or maximum limit. 

 
T   after the correction 
has been made (after pressing OK), and data will be changed accordingly. You can 
find more about reconverting in chapter 10. 

8.8 Time Synchronous Data (TSD) 

Choose the Settings menu, TSD definition command. A dialog box appears: 

Figure 8.9 Time Synchronous Data Settings 
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If the user wants to time synchronize two or more data files, it is possible to select 
three options: 1 hour, 10 minutes, or 5 minutes. The restriction is that the sampling 
interval selected must be greater than the initial interval, and it must also be dividable 
by the initial interval. For example, if the initial interval was 15 minutes, only the 1 hour 
option can be selected for time synchronous. 
 

measurements in the original file that are not to be shown. 
 
If the user wants to activate this ake TSD file when converting DAD-

 For changing the current measurement file with one of the 
  

8.9 Rate Of Change (ROC) 

This new feature gives the user a chance to see how fast the signal is changing, i.e. 
the estimated velocity of the signal. This applies to all measured parameters. The ROC 
is calculated via a two point numerical differentiation: 
 

ROC= (P2-P2)/(t2-t1) 
P: Parameter expressed in a user defined unit 
t: Time (hour, minute or second) 

 
The way the ROC is set up and viewed is very similar to the TSD. 

\  

Figure 8.10 ROC Definition 
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The ROC is only computed when a DAD->DAT conversion is performed, and when 
the user wishes. The time units are selectable as hour, minute or seconds. For small 
changes it can be convenient to express the ROC as a milli (10-3) unit. For example if 
the depth is in meters (m) then millimeters are expressed as (mm). 
 
The ROC \Data Trend and Table\Rate Of 

\Measurement Data\  

8.10 Chart 

Title 

Click on the title name to change the title of the chart. A dialog box appears: 

Figure 8.11 Chart Title Dialog Box 

The chart is automatically assigned the data file number as a chart title. To change the 
chart title, enter a new text string and press the OK button. 

Time Axis 

To change the time scale of the chart, click on the X-axis scale. A dialog box appears: 

Figure 8.12 X-Axis Settings Dialog Box 
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By disabling the Automatic option, the minimum and maximum time values become 
active. By clicking on the Change buttons for the maximum and minimum values, the 
time range can be specified. For creating (saving) a new data file (DAT) with a new 
specified time scale, please refer to chapter 10.Reconvert. By enabling the Automatic 
option, the measurement time will go back to the initial range. 

Value Axis 

To change the scale settings for the value axis, click on one of the Y-axis scale. A 
dialog box appears: 

Figure 8.13 Y-Axis Settings Dialog Box 

By disabling the Automatic option, the minimum and maximum measurement values 
become active. By clicking on the Change buttons for the maximum and minimum 
values, the range to be shown on the chart can be specified. By enabling the 
Automatic option, the measurements will go back to the initial range. 
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8.11 Chart Editor  

The Chart Edit button (on every graph) gives access to the Chart Editor, a multi-
option menu, now with a Tree View interface, as can be seen in figure 8.14.  
There are five main branches on the tree. 
 

 Series 
 Chart 
 Data 
 Tools 
 Export 

The tree menu gives access to the same features as the tab menu described in the 
changes invoked are viewable immediately. 

All format and style changes made to the chart, are lost if the data are viewed again or 

the chart or the database.  

Series 

The Series window . 

Figure 8.14 Chart Editor 

When a particular series is selected, like the Temperature series for example, a two 
tab menu is revealed, as seen in fig. 8.15, where the user can 
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Figure 8.15 Format Series 

Chart 

The chart branch has six sub branches: 
 

Axis 
Titles 
Legend 
Panel 
Paging 
Walls 

Axis 
There are 8 axis in a normal SeaStar chart, the number in use depends on the 
recorder type. The Left Axis and Custom 1 axis are always in use, the latter is reserved 
for the timeline. 
 
Figure 8.17 shows a six tab Axis menu. There are numerous options, some of which 
can drastically change the behavior of the graph. The Minimum and Maximum tabs 
give options similar to the menu offered when clicking a axis on the graph, the ticks 
tab gives 
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Figure 8.16 Axis Formatting 

Titles 
The Titles menu shown in figure 8.17, gives access to 4 tiles, each title a multi line text 
window, which can be positioned anywhere on the chart. There are multiple formatting 
options, six tabs, for each title. 

Figure 8.17 Titles Menu 
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Legend 
The legend menu (see figure 8.18) gives the user an option of showing a series 
legend. 
The 8 tab menu gives options in styling positioning and formatting the legend. 

Figure 8.18 Legend Menu 

Panel 
The Panel menu (see figure 8.19) offers panel format options. Images, pictures and 
icons can be imported onto the panel as a back image. 

Figure 8.19 Panel Menu 
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Paging 

Figure 8.20 Paging Menu 

With the Paging menu, shown in figure 8.20, the data series can be chopped into 
pages, with a user defined number of points per page. Only one page is shown at a 
time, and the user can scroll through the pages via the page buttons, that appear (are 
enabled) on the chart to the right of the Edit Chart button, when paging is selected. 
Paging can be useful for viewing distinct time periods, one at a time, days or hours for 
example. No offset is offered and sampling periods and start time can limit the 
usefulness of this option. 

Walls 
The walls menu, as seen in figure 8.21 gives access to configuration of four walls, but 
as SeaStar  
The Walls menu, has similar options as the Panel menu, when defining a pattern, via 

1, an image can be imported and placed 
on the wall. In fact, 
can enhance an image on the panel, or the image on the panel can be seen through 
the wall with the Transparency option. 
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Figure 8.21 Walls Menu 

Data 

In the data menu, seen in Figure 8.22, gives the user access to the database, upon 
which the chart rests. Here text labels can be set to each measurement point. 
Changes can be made to the time and measurement values. Changes made to the 
data, are included when the data is exported, but if the data are viewed again or 

affected by 
changes made to the database. 

Figure 8.22 Data Menu 
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Tools 

Under 'Tools' you will find several options to customize the setting of the cursor and 
the appearance of the graph, such as page numbering, font, font size etc. To 
active/deactivate the chosen setting check/uncheck the 'Active' box on top of the first 
page of this menu. 

Figure 8.23 First Page of Tools Menu 

Export 

Under the Export menu, three tabs offer as many menus for saving data as: 
 

Pictures 
Native (data) 
Data (file) 

Pictures 

Figure 8.24 Export Menu: Picture 
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Figure 8.24 shows options when saving the chart as a picture to a file, or copy the 
picture to the clipboard. There are seven format possibilities: 
 

 Metafile 

 Bitmap 

 JPEG 

 GIF 

 PDF 

 VML 

 SVG 

Native 
The Native menu, see figure 8.25
these files is not supported in SeaStar at the moment. 

Figure 8.25 Export Menu: Native 

  

Distributed By MicroDAQ, LLC     603-746-5524       www.MicroDAQ.com



User Manual      SeaStar Graphic Supporting Software 

©2015 Star-Oddi. All Rights Reserved Page 63 

Data 
Data can be exported to files in four formats, see figure 8.26. 
 

 Text file (.txt) 
 XML (.xml) 
 HTML (.hml) 
 Excel (.xls) 

Figure 8.26 Export Menu: Data 

There are four Include options: 
 

1. Point Index 
The point index is the same as the measurement number, but offset by -1, as it 
starts in 0 instead of 1.  

2. Point Labels 
If the user has added text labels to points in the DATA menu, these can be 
included.  

3. Header 
The same headers as are in the DATA menu.  

4. Point Colors 
This option is not relevant in SeaStar. 

 
Another method for exporting is to use the Alt+PrintScreen keyboard buttons to copy 
an image of the SeaStar window to the clipboard, thereafter to paste it to another 
Windows application. When a dialog box is open, then only that frame is copied to the 
clipboard. 
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To copy a part of a data file, for example from a DAT file, then highlight the part you 
want to copy and use the Ctrl+C keyboard buttons to copy the data snippet to the 
clipboard. Then use the paste-option in another Windows application to transfer the 
data from the clipboard. 

Figure 8.27 Highlighted Text to be copied 

8.12 Timeline  

The timeline is a graphical viewing aide. Every time a file is loaded for trending, an 
extra time value is calculated for every measurement point. These time values form the 
Timeline. The Timeline is an extra series that follows the rules of the other 
measurement series. When the graph first appears, the Timeline is inactive. 
By selecting the Timeline in the Series List (see fig. 8.28), the Timeline becomes 
visible as shown in figure 8.29. 
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Figure 8.28 Timeline Selection 

Figure 8.29 Timeline on a gr  

The Timeline is defined under Settings\Preferences\Timeline.  
There are several options for the Timeline, as can be seen in fig. 8.30. 
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Figure 8.30 Timeline Options 

There is no need to reconvert the data, as every time a data file is loaded, the Timeline 
is calculated in accordance with Timeline settings. The Timeline is not a part of the 
*:DAT or the *.TSD files, but if the data is exported (see the Export section), then the 
Timeline, if selected, will be included. Thus, the Timeline can also be used for 
statistical purposes. 

8.13 Templates  

There are two scenarios where templates come in handy: 
 

1. When many recorders are programmed with the same settings (multi mode), 
and circumstances are in a way that the user cannot complete the setup of all 
the recorders in one session, and he has to exit SeaStar (to continue later). 

2. When the user wants to reuse, partly or completely, presumably a complex 
and/or lengthy measurement setting. 

Saving a Template 

The user can now, when editing New Measurement Settings (NMS), save his work by 
1), before 

acknowledging OK from the Edit NMS menu. Having selected this option and the 
NMS are OK, then the user has an option to write a description for the template (see 
fig. 8.33). Canceling this option 
an INI file and saved in the SeaStar\NMS directory. The name of the file is 
MST<date><type letter>time<Interval mode>.INI 
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Figure 8.31 Template Options in Edit\New Measurement Sequence 

Figure 8.32 Saving NMS as a Template 
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Using a Template  

Templates can be retrieved at a later time to be used directly or modified. The list of 
templates is kept in the SeaStar\templets.ini file. 
There are three buttons in the Edit NMS window as can be seen in fig. 8.31. The top 
button is used for retrieving a template. 
As can be seen in fig. 8.33, templates are selected via template name or description. 
Parallel to selecting a template, descriptions can be edited and eventually templates 
deleted. 
The recorder type and interval type, which the template was based on, are visible for 
each template. 

Figure 8.33 Template Selection 

Templates can be used across recorder type boundaries and interval types. 
Things to keep in mind when selecting a template are: 
 

 Single interval templates converted to a multiple interval NMS. All seven 
intervals are the same. 

 Multiple interval templates converted to a single interval NMS, set the interval 
as interval one. 

 Start time in the past is not allowed as will be apparent when exiting the Edit 
NMS window. 

 Some recorder types are less compatible than others, an example of that is a 
DST milli template converted to a DST GPS NMS. 
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After selecting a template the user is returned to the edit window. If the selection is 
revious setting. 

 
The user has one more option to quickly set up the NMS. The button in fig. 1, marked 

and return four different settings depending on the status of recorder and 
measurement selection. 
 

1. Use Default: No recorder selected. 
2. Use Recorder: Recorder selected but not a measurement sequence. 
3. Use Sequence: Measurement sequence selected. 
4. Use Online: Recorder is on-line. 
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9. Multiple Intervals 

SeaStar has the option for setting up more than one sampling interval within a 
measurement sequence. Reasons for wanting multiple intervals can be to save 
memory, but still be able to have frequent measurements in between. This may be the 
case with fish tagging, when frequent recording is wanted in a specific period in the 
fish life cycle. If you want to run on a single interval the whole recording period, this 
option is not selected. 
 
Select Multiple recording intervals in the wizard or choose the Edit menu and the 
New Measurement Sequence Definition command. Select Multiple Intervals and 
the following dialog box appears: 

Figure 9.1 Set New Measurement Sequence (with multiple intervals) 

9.1 Start time 

The user defines the date and time when recordings should start. 

9.2 Measurement Interval 

The sampling interval (time between measurements) is defined. Any value from 1 to 99 
seconds, or 1 minute to 24 hours with increments of 1 minute. Up to 7 different 
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sampling intervals can be selected. If seconds are used as sampling interval, the 
multiple of the sampling interval and the number of measurements must be dividable 
by 60. 

9.3 Number of Measurements N1-N7 

The user defines the number of measurements to be recorded within each sampling 
interval. A value from 1 to 60000 must be set. Please note that an inital measurement 

 This initial recording is not counted as a 
 For example if the recorder 

should measure every hour from midnight to ten o  10:00), then the 
number of measurements defined should be 10. Please note that only this one 

 In 
 is at 01:00, and the last 

measurement is at 10:00, and then it shifts to another interval. 
 

interval in the sequence and take the number of measurements as defined. After 
taking the measurements on the first interval, it will automatically shift to the next 
interval etc. The sampling intervals and number of measurements will recycle until 
memory is full, or until connection is made with the recorder through a PC computer. 

9.4 Sequence 1-14 

The interval sequence must be filled out. As shown in figure 10.1, the user selects to 
use intervals 1-6 for the recordings. Another example:  
If two of the first sampling intervals are used, the sequence should be 1, 2, 1, 2 etc., 
meaning that the recordings shift between the first and the second intervals, recording 
the defined number of measurement for the first interval, and then shifting to the 
second interval taking the number of measurements defined. The shifting between the 
intervals repeats until memory is full, or until connection is made through a PC 
computer.  

9.5 Primary/Secondary 

With default setting, both Temperature-Depth (TD) and Tilt is recorded at each 
sampling interval (TD-Tilt normal). The user has the option to select either TD or Tilt as 
a primary sensor for each sampling interval. The objective with this feature is to save 
memory size, increase recording period, and get more data on the sensor that is of 
more interest (primary sensor). 
 
The secondary counter is only meaningful if a primary parameter has been selected. 
The secondary counter defines how frequently the secondary parameter is saved 
along with the primary parameter. If for example Tilt is selected as a primary sensor, 
and the number 3 is defined as a secondary counter, the TD will only be recorded 
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every third time when Tilt is recorded. If the value is 0 (zero), the recorder is in 
principle a Tilt only, except the first measurement is always a TD-Tilt measurement. 
 
There are restrictions on the secondary counter settings when multiple intervals are 
defined. If a primary parameter is selected and secondary counter is 0 then the 

 If a primary 
parameter is selected 
counter, and only odd numbers (0,3,5,7...255) can be used as a secondary counter. 
 
The Use Template can be used if older definitions have been saved by enabling the 

 
been set up in the past. With the Use Sequence button it is possible to get same 
settings as from other recorders, by browsing for their serial no. By hitting the 
Previous button the settings go back to previous, before changes were made. 
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10. Reconvert Data 

In SeaStar you have the option of reconverting data that has already been retrieved. 
After re-   The 
main reasons for reconverting data are: 
 

 Adjust the center point for the pitch and roll measurements. 
 Shift pressure/depth values according to a reference meter, to increase 

accuracy. 
 Adjust measurements that are outside calibration range. 
 Incorrect PC-time at measurement start time. 
 Need for temperature or pressure/depth unit alteration. 
 Need for data file format alteration. 

10.1 Data Reconvert Definition 

Under the Edit menu and Reconvert Definition, choose the Data Definition 
command, and the following dialog box appears: 

Figure 10.1 Reconvert Data Definition  
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Set Reconversion Measurement Sequence Start-Time 

If the user notes from retrieved data that the PC date and clock were incorrect when 
measurements were started, it is possible here to specify a new start date and start 
time. 

In Reconversion use Measurement Intervals from 

The measurement interval is either the interval settings as shown in the measurement 
(MID) file, or if that interval is incorrect, a new and correct sampling interval is 

 

In Reconversion se Constants from 

The user can choose to use calibration constants from: 
 

 MID file. This option should normally be selected, as it contains information on 
the constants from the measurement sequence. 

 RID file. The recorder information file contains the same calibration constants 
as the MID file, except if it has been re-calibrated. If it has been re-calibrated, 
and the user wants to use the new constants on older measurements, the RID 
option should be selected.  

 RBD file. This option rarely needs to be selected. If the constants from the MID 
and RID file are corrupt, the user should contact Star-Oddi for an RBD file. 
See chapter A.3 for instructions on how to transmit the RBD files to the 
recorder. 

Convert Number of Data 

The user can reconvert all the data in the last measurement sequence, or define the 
number of measurements to be reconverted. The user has the option to define what 
measurement range should be reconverted (for example to exclude data points when 
the recorder was above water). 

Time Linear Adjustment 

The real time clock inside the DST has an accuracy of approximately +/- 1 minute per 
month. This slight variation might accumulate over time and influence the 
measurement results. To correc

 

Out of Range Decimal Value Settings 

Measurements that are outside the calibration range are inaccurate, and may give 
erroneous results. The out of range (OOR) measurements can be seen in the OOR 
file. The user has the following decimal value out of range detection options when 
reconverting: 
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 Full scale (no boundaries).  
will be made. 

 User definition. - Out 
Of Range -  This option is selected when the 
decimal values (DV) are not available in the RID file. This would normally 
require the user to contact Star-Oddi for the decimal values. 

 RID values. The calibration decimal range is given in the RID file. This is the 
default option and should normally be selected. 

 
If an RBD file exists in the \SeaStar\RBD folder, then SeaStar recognizes this file as a 
primary source for DV calibration range. In this case, the fourth option appears and is 
set as default. 

Temp. correction outside temp. calibration range 

The user can choose to apply temperature correction for measurements that are 
outside the temperature calibration range. 
 
Normal correction: Measurements are always temperature corrected 
Limit correction: Temperature correction is limited to calibration range 
No correction: Temperature correction is not applied. 

10.2 Temperature Definition 

Under the Edit menu and Reconvert Definition, choose the Temperature Definition 
command, and the following dialog box appears: 

Figure 10.2 Temperature Reconvertion Definition 
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Offset Adjustment 

When recorders are used over a long period of time, the temperature measurements 
can start to deviate from correct values.  
When checking older recorders, it has come apparent that the error in the 
measurements is mainly due to an offset. Some users feel they can benefit from an 
offset correction option in SeaStar, for example when a recorder has been in the water 
for a long time and is later tested to show an offset. The offset is defined in m°C 
(1000 m°C = 1°C). 

Single spike correction 

Check Use Single Spike Correction. There are two variables, Time and Limit. The 
Limit defines how much difference can be between two points over a defined Time. 
 
If a point is outside the range, +/- the limit of adjacent points. That point is then 
calculated as the average of the adjacent points. 

Temperature response shift 

It is possible to set the desired start/end point to be shifted by X seconds. This shift 
can only be performed on data with an interval of 1 second. 

Linear estimation outside calibration range 

Check this option to linearly estimate temperature measurements outside of 
calibration range. 
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10.3 Pressure Definition 

Under the Edit menu and Reconvert Definition, choose the Pressure Definition 
command, and the following dialog box appears: 

Figure 10.3 Pressure Reconversion Definition 

Disable Temperature Correction in Pressure Calculation 

In case the temperature sensor is malfunctioning in a way that it will indicate very high 
temperature values, it will offset the pressure calculation. An automatic temperature 
correction is set by default in SeaStar. To turn off this feature, check the box next to 

 

Pressure Offset Adjustment 

The user can increase accuracy of pressure/depth recordings by finding an offset 
v

 Once the offset point has been set in, the data can be reconverted, and 
all pressure/depth recordings shifted according to the value defined (in mbar). 
 
In cases where a drift has occurred with the pressure recordings, the pressure data 
can be corrected if the user has a known reference point for correcting the data. To 
find the offset value, the recorder should be deployed in water, at a known depth 
(preferably >2 m depth), or placed along with an accurate reference depth meter, 
where a reference point can be taken. Once the offset value has been found, the 
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offset pressure value is put in the window shown above. The offset value can either be 
subtracted or added to the pressure values.  
 
When using 9.81 as g, the coefficient for converting cm into mbar is 1.019 (for 
example, 100 cm = 101.9 mbar) 
enabled, the offset value is fixed for that particular recorder, and future data uploads of 
the recorder will use the offset value defined, for shifting the pressure data. The offset 
value will apply only to that particular recorder, and other offset values can be defined 
for other recorders.  

Pressure Linear Adjustment 

Aging of the pressure sensor can result in an offset of the measured pressure values. 
To correct these offset values you can select a linear pressure adjustment. Check 

expected value and real value at the end of the recording period) and the length of the 
measuring period. 

Linear Estimation Outside Calibration Range 

The pressure sensor tolerates a significantly higher pressure than its calibration range. 
If the recorder is exposed to higher pressures than its calibration limit it will result in 
erroneous data. By choosing this option you will receive more adjusted values. Please 
note that since these values are outside of the calibration range an exact adjustment is 
not possible, this feature is mainly for estimation purposes. 

Depth Calculation 

For converting the pressure units to depth, the standard for the acceleration of gravity 
is 9.81 (1 bar = 1000 mbar = 9.81 m. 100 cm = 101.9 mbar), but it can optionally be 
set from 9.78 to 9.83, depending on the gravity in the different areas of the world. 

Single spike correction 

Check Use Single Spike Correction. There are two variables, Time and Limit. The 
Limit defines how much difference can be between two points over a defined Time. 
 
If a point is outside the range, +/- the limit of adjacent points. That point is then 
calculated as the average of the adjacent points. 

Step Correction 

The Step Correction option is mainly intended for those users who are doing research 
on fishing gear such as long lines and trawl doors, although it might benefit other 
users as well. 
 
When the recorder has been on deck for a long time there is a significant temperature 
change when it hits the water and as a result the normal temperature corrector might 
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not function correctly In order to avoid inaccurate measurements, the user has the 
option of using a fixed value in the temperature correction. 
 
In the From field (see figure 10.3) enter the number of the measurement when the 
sensor hit the water and in the To field enter the number of the measurement when 
the temperature became stabilized. The temperature value of the latter measurement is 
entered in the Temp field. This fixed value is then used to correct the pressure value. 
The graph in figure 10.4 displays the difference between normal correction (red line) 
and step correction (blue line). 

Figure 10.4 Normal vs. Step Correction 
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10.4 Tilt Reconvert Definition 

Under the Edit menu and Reconvert Definition, choose the Tilt Reconvert Definition 
command and a dialog box appears: 

Figure 10.5 Tilt Reconvert Definition 

Single spike correction 

Single spike correction works with nocks and bumps, sudden spikes that can clog up 
s over the 90° boundary line. 

 
Check Use Single Spike Correction. There are two variables, Time and Limit. The 
Limit defines how much difference can be between two points over a defined Time. 
 
If a point is outside the range, +/- the limit of adjacent points. That point is then 
calculated as the average of the adjacent points. 

Angle Offset Adjustment 

 The X, Y and Z 
angles can be adjusted. The offset value can either be added or subtracted. 

New Tilt Range Values 

enabled and not configured by the user unless with 
consultation from Star-Oddi. The purpose of this feature is to put in a new range when 
recalibrating the X and Y axis of the compass. 
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Reconvert Data 

After acknowledging the offset adjustments, the data need to be reconverted, for the 
adjustments to be effective: <File\Reconvert Data>. 

View Previous Conversions 

Each time a reconversion is performed, a numbered file is created in the sequence 
folder. To view previous conversions select a file under View and choose Previous as 
can be seen in figure 10.6. 

Figure 10.6 Previous Conversions 

The window in figure 10.7 appears. Select a numbered file from the drop-down list. 

Figure 10.7 Select Previous Conversions 
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Reconvert Previously Retrieved Data 

If data from the same sequence is retrieved more than once, a bookmarked data 
sequence file (DAD) is created. These files can be accessed and reconverted by 
choosing File-Reconvert data-Previous as can be seen in figure 10.8. 

Figure 10.8 Reconvert Previously Retrieved Data 
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11. Recorder Modes 

In this chapter, the three operational modes of DST tilt are described, that is the PC 
Mode, Sleep Mode and Measurement Mode. 

11.1 PC Mode 

If the recorder is in the correct position in the Communication Box, and by choosing 
the Recorder menu and the Connect command, the recorder is put into PC Mode. At 
the bottom of the SeaStar window, the text On-line is displayed, indicating that the 
recorder is on-line and in PC Mode. 
 
While in PC Mode, the recorder will remain in an active listening stage. The 
communication protocol is a simple master/slave arrangement, in which the recorder 
is the slave. The slave will perform every command the PC issues, and after execution 
of a command, it will return to listening. When the recorder is connected to the PC, it 
is powered by the PC, and not taking energy from the battery inside the recorder. 

11.2 Sleep Mode 

The user receives the recorder in Sleep Mode, but it can easily be awakened by the 
Connect command in the Recorder menu. If the recorder is not set in Measurement 
Mode, it goes into Sleep Mode when the recorder is removed from the 
Communication Box. When the recorder is in this mode, less energy is depleted from 
the battery. 

11.3 Measurement Mode 

The recorder is put into Measurement Mode by choosing the Recorder menu, and 
Start New Measurements Sequence. The recorder starts recording measurements 
according to the start time (date/month/year) and sampling interval (hours/min.) 
defined by the user. 
 
When the memory is full, the recorder shifts automatically into Sleep Mode. If the 
recorder is still in Measurement Mode upon connection through a PC computer, it 
stops recording and is put into PC Mode. 
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12. Memory and Battery 

12.1 Memory Organization 

The memory capacity in DST tilt is 20,000 measurements for each sensor. Data is 
kept in an EEPROM memory and will not be lost if the battery fails or expires. The 
memory of the recorder is organized as shown in the figure below: 
 

New recordings
Unused memory/
Old recordings

V
V Data memory

Settings V

 

Figure 12.1 Data Memory Organization 

When data is retrieved from the recorder, the following occurs: 
 

1. The computer retrieves the data from the recorder and writes the data to the 
 

2. The recorder has stopped recording, but still holds the recorded data. 
 
When new settings are sent to the recorder, the following will occur: 

1. New settings are sent to the recorder. 
2. The data memory pointer is reset to the beginning of the data memory and 

starts to write over older recordings. 
 
The organization of the memory is now as follows: 
 

Unused memory/
Old recordings

V
V Data memory

Settings V

 

Figure 12.2 Data Memory with New Settings 
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12.2 Battery Calculations 

The voltage characteristics of the batteries used in our recorders make it almost 
impossible to measure the energy available in the batteries, therefore we estimate the 
energy consumption by calculation. All the energy consuming functions of the 
recorder, like sleep, decay, running (microprocessor awake), measurements and 
saving data are measured beforehand and used in our calculations. The calculations 

recorders themselves do not perform any energy calculations, but in order to start the 
recorder in one computer and retrieve data in another while still having the battery 
energy information, they carry the percentage of remaining energy with them in a 
register file (in the RID). At the time the recorder is in production (when the battery is 
new) the energy number is set to 100%. 
 
Each time the recorder is started up in a new measurement sequence, the energy 
consumption, since last sequence-start, is calculated and subtracted from the energy 
number retrieved from the recorder, and this new energy-left number is downloaded 
into the recorder. 
 
The energy-left register in the recorder can be corrupted for reasons such as: 
 

 The CRC check is turned off when connecting to the recorder and a 
communication error occurs 

 When a write error occurs when starting up a new sequence or updating a 
status to the recorder and a reconnection is performed instead of performing 
the operation again. 

 Energy estimation calculations are not in accordance with actual energy 
consumption. 

 
To change/correct the battery energy numbers in the recorder refer to chapter 13.5. 
  

Distributed By MicroDAQ, LLC     603-746-5524       www.MicroDAQ.com



User Manual      SeaStar Graphic Supporting Software 

©2015 Star-Oddi. All Rights Reserved Page 86 

13. Wizards 

There are six wizards in SeaStar: 

13.1 Connection Wizard 

Figure 13.1 Connection Wizard 

Choose the Wizards menu and the Connection Wizard command to enter the 
connection wizard (see figure 13.1). 

13.2 Com Box Connection 

Figure 13.2 Com Port Wizard 
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Choose the Wizards menu and the Com Box Connection command to enter the 
Com Port wizard (see figure 13.2). The wizard goes through available ports and 
activates them one at a time and asks the user to confirm that the communication box 
displays a yellow light (see figure 13.3). 

Figure 13.3 Com Port Wizard 

13.3  Start Recorder 

Choose the Wizards menu and the Start Recorder command to enter the wizard 
(see figure 13.4). 

Figure 13.4 Start Recorder Wizard 

This wizard starts the recorder with a new user defined measurement sequence. 
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13.4 Retrieve and View Data 

Choose the Wizards menu and the Retrieve Data command to enter the wizard (see 
figure 13.5). 

Figure 13.5 Retrieve Data Wizard 

This wizard retrieves data from the recorder and offers the user to start it again with a 
new measurement sequence. 

13.5  Quick Retrieve and Restart Recorder 

Choose the Wizards menu and the Quick Retrieve command to enter the wizard 
(see figure 13.6). 

Figure 13.6 Quick Retrieve Wizard 

This wizard retrieves data from the recorder without graphically displaying it and offers 
the user to start it again with a new measurement sequence. 
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13.6 Change Battery Life 

A new wizard has been added to the Wizards menu, the Change battery life wizard. 
 
Choose the Wizards menu and the Change battery life command to enter the 
Change battery life wizard (see figure 13.7). 

Figure 13.7 Change battery life 

Select the recorder type and insert the recorder in the Communication Box. Once a 
connection has been established a window appears (see figure 13.8). If the recorder 
is already on-line then the wizard will start in step 4 (Set New Battery Life). 

Figure 13.8 Set Battery Life 

The top line shows who long the recorder has been in use since (last) calibration, and 
how much energy sleep and decay combined have used up over that time. 
 
The second line shows Battery left based on the register in the recorder. 
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There are two ways to set the battery life, Direct definition and Calculate from NMS. 
 
Direct definition: 
Check the Direct definition option and set the battery life (in %) manually based on 

used since then. The user can also refer to other same type recorders working under 
similar conditions. 
 
Calculate from NMS: 
Check the Calculate from NMS option and click on Calculate NMS. The user is now 
transferred to the Set New Measurement Definition window where a sequence can 
be defined. Once the measurement sequence has been defined an Estimated 
measurement battery usage pr week (%) is calculated and shown in the Set New 
battery Life window, note that sleep and decay energy use is included in this number. 
Also the Calculated total battery used (%), which is based on the NMS definition 
times number of weeks, plus the energy used by sleep and decay. 
 
Now insert for how many weeks the recorder (since produced) has been measuring. 
Each time the number of weeks is changed, the Calculated total battery used(%) is 
recalculated, note that the Calculated total battery used(%) value will not show a 
directly weeks * energy pr week, as the sleep + delay values must be accounted for. 
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14. Group 

Creating a group is a way to gather multiple measurement sequences which are part 
of the same research project into one group. In a group the user can track when the 
logger was started, the data retrieved and the data converted/reconverted. Groups 
can be transferred to PatternFinder for further data analysis 

Figure 14.1 Group menu 

New Group 

Select New Group to create a new group. Please note that it is also possible to 

create a new group by clicking the New Group button  in the group view pane. 
The following window appears: 

Figure 14.2 New Group 

Name the group and enter a description. The group file will be saved under the 
directory: C:\SeaStar\Groups. Each group has its own subfolder where data files from 
each sequence in the group are stored, this way the data can be accessed from 
PatternFinder and Gná. 
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Open Group 

Select Open Group to open the Group directory. It is also possible to open the 

directory by clicking the Open Group button  in the group view pane. 
 
Once a group has been selected the group view pane appears: 

Figure 14.3 Group view 

Adding sequences to group 
To add a sequence to the group connect to a logger and define and start a new 
measurement sequence. When starting the new sequence the following window 
appears: 

Figure 14.4 Add Sequence to Group 
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Set an alias for the sequence and enter a description. Click OK and the sequence will 
be added to the group (see figure 14.5). 

Figure 14.5 Group view pane 

If a group is open when starting up a logger the new measurement sequence will be 
automatically registered in the group. If no group is open the sequence will not be 
registered in any group. 

Retrieving data 
When retrieving data from a logger and the sequence is already in a group the data 
retrieval time is registered in the group. Also when the data is converted/reconverted a 
copy of the *DAT file is stored in the group folder. 
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Send Group To 

Select Send Group To to transfer a group to another software. 

Figure 14.6 Send Group 

It is also possible to transfer a group by clicking the Send Group to button  in 
the group view pane. 

Close Group 

Select Close Group to close an open group. 
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Appendix 

A.1 Directories and Files 

Directory Structure 

The user can choose between SeaStar  default data directory structure (path) or 
define his own data path. As the SeaStar program is a multi recorder type program, 
the directory structure branches from the directory where SeaStar is positioned down 
to type directories, i.e. Starmon mini, DST tilt etc. From there it branches again into 
recorder directories, named after the serial numbers of the recorders, designed to 
hold data for each individual recorder (data directory). All in all it is a three level 
directory structure. 
 
An example of this directory structure with DST tilt is: 
C:\Seastar\   The installation directory (SeaStar.exe location) 
 
C:\Seastar\DST tilt\  The type directory for DST tilt 
 
C:\Seastar\DST tilt\I2018\ The directory for the I2018 recorder 
 
When a new recorder type is selected in SeaStar (File  New Recorder Type), the 
directory for that recorder type is created. When connecting to a recorder for the first 
time, SeaStar creates the recorder directory, named after the serial number of the 
recorder. 

Information Files 

SeaStar uses information files to store and retrieve settings. There are two types of 
information files: 
1) The type-INI files, (for example DSTx.ini for DST tilt). 

The information type files are all in the installation directory, they contain 
information on specific settings for each type. The type-INI files are: 
 

StarmonT.ini Starmon mini 

DSTm.ini DST milli 
DSTr.ini DST milli recycle 
DSTu.ini DST micro 
DSTc.ini DST centi/centi-ex 
DSTs.ini DST CTD 
DSTg.ini DST GPS 

 
2) The recorder-INI files, for example I2018.ini contains settings information and data 

file positioning for the I2018 recorder. The recorder-INI files are located in the 
appropriate type directory, i.e. all the Q tilt  
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Files Locations 

As stated previously, the type-INI 
recorder-INI files are placed in the recorder type directory. All other recorder and 
measurement related files created by SeaStar, are placed in the appropriate 

 For example: 
C:\SeaStar\DST tilt\I2018\ is a directory for the I2018 recorder and all files belonging 
to I2018 are placed there. 
 
If the user whishes to use his own defined data path, for example C:\Data\, then all the 
files for all the recorders, except for the INI files, are placed there. If the user has 

recorder directories, irrelative to type, are created under the user defined path, for 
example: C:\DATA\I2018\ for the I2018 recorder. The I2018.ini file (located in the 
C:\SeaStar\DST tilt\) contains the path to the C:\Data\I2018\ directory, and all files 
related to the I2018 will be placed in that particular directory. 

Browsing for a Recorder 

the default method is to find a recorder-INI file in the type directory. The INI file will 
 If the user has enabled the 

ser path definitions, the search starts in the 
user defined directory, where a *.RID file must be selected. 

Recorder Related Files 

Every file that is recorder related has the following name format: 
  Xnnnn: The name is the serial no. of the recorder 
 

Ext Description File type 

RID   Recorder information data Binary 
RIT Recorder information text Text 
RBD Recorder backup data Binary 
RDD Recorder SNMS* download information data Binary 
RDT Recorder SNMS* download information text Text 

*SNMS: Start New Measurement Sequence 

The recorder ID (RIT) can at a later time be opened, and the related measurement 
data can be viewed, printed and reconverted. The RDD, RDT and DIR are download 
information files, created when a new measurement sequence is started. 

Measurement Related Files 

Every file that is specifically measurement related has the following name format: 
 
 mmmXnnnn: The name is the measurement number + serial no. 
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Ext Description File type 

MID  Measurement information data Binary 
MIT Measurement information text Text 
MDD Measurement download information data Binary 
MDT Measurement download information text Text 
CIT Measurement conversion information text Text 
DAD Measurement Data Binary file Binary 
DAB Measurement Data Binary file Text 
DAT Measurement Data Binary data Text 

 
The MID, MIT and DAD files are created upon measurement data retrieval from the 
recorder. The DAB, DAT and CIT files are created when converting the data. The 
MDD and MDT are download information files and created when a new measurement 
sequence is started. 

Data Files 

Upon data retrieval, three main data files are created.  

The *.DAD File 
This file is the raw data source file. The data is in mixed binary form. The user cannot 
access this file in the SeaStar program. When converting these raw data into 
measurements, the *.MID file is needed. The result from the conversion are two data 
files, the *.DAB and the *.DAT. 

The *.DAB File 
This file contains sequential binary representation of the data in columns. The first 
column is the measurement number. The other columns contain the measured 
parameters in a binary form. 

The *.DAT File 
This is the actual result file, where the measurements are converted to their natural 
units and timed. This is a text file with columns. The first column is the measurement 
number, the second column the date and the time, depending on the set-up. The third 
column is the time or the first measured parameter, depending on set-up. The 
following column(s) contain the converted measured parameters with units and 
number of decimals according to set-up. Number of parameters can range from 1-3, 
and number of columns 3-6 accordingly.  
Data Header 
The *.DAT file contains a data header, which is a detailed description of how the 
*.DAT file is configured. This feature is used by SeaStar when graphically 
representing the data, and is practical if the user wants to import the data into other 
applications or databases. Most of these descriptive items are derived from the 

  
 
Each header item is contained in one line, and all header lines start with a # 
(bookmark) and a number. Then follows a description of the header item, and then 1-4 
directives, all separated by tabs. Eventually a comment trails the directives, preceded 
by a ; (semicolon). 
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A.2 Help Menu 

Choose Help and the following window appears: 

Figure A.1 Help Menu 

User Manual 

Select User Manual to open the DST tilt user manual. 

Troubleshooting  

Select Troubleshooting to open the Trouble-Shooter. 

Release Notes 

Select Release Notes to view a description of the latest features added to SeaStar, 
the date they were added and a reference to the chapter number of each manual 
where the additions can be found. 
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Check for Updates 

Select Check for Updates to manually update the latest version of SeaStar, User 
Manual, Trouble-Shooter and Release Notes. The following window appears: 

Figure A.2 Select files to download 

Select the files you want to download and click OK. The program downloads and 
installs the latest updates to the software. Please note that this can only be done 
when the program is offline i.e. when no recorder is connected to the program. 
 
Change Log is displayed if a new application version is available while updating (see 
figure A.3) 

Figure A.3 Change Log 
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By selecting Settings-Options-Update you can now choose whether you want to 
update SeaStar manually, every X number of days or every time SeaStar is run (see 
figure A.4). 

Figure A.4 Update 

Submit ticket 

Tickets can now be sent directly from the application to our support department by 
selecting Help-Submit Ticket. A shortcut key, F1, can also be used at any time while 
in the application and is especially useful when the menu bar is disabled. 
 
In the ticket form (see figure A.5) you can add your name and email. Select a category 
that best describes your problem and write a subject and description. If you like you 
can select Images (screenshots) and browse for images in the screenshots folder 
and send them with the ticket. By selecting Other files you can also add files to the 
ticket. To automatically add recorder data use the Include Recorder Data option. By 
default the following files are included: screenshot, system information, logs and 
settings. These can be excluded with options in Other files. 
 
To receive a response we require that you include a valid email address. 
Tickets can also be created by e-mailing support@star-oddi.com with the problem 
description and files attached. 
 
If you want to add more information to a previously created ticket you can reply to the 
support response. 
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Figure A.5 Submit ticket 

About 

Select About for general information about SeaStar. 

A.3 Recorder Backup 

As mentioned in chapter 10, if the constants from the MID and RID file are corrupt, the 
user should contact Star-Oddi for a RBD file and transmit it to the recorder.The name 
of the backup file is Txxxx.RBD (serial no. of the recorder plus the .RBD ending). 
 
Downloading the backup file: 
1. Copy the backup files (RBD) into the SeaStar RBD directory. 
2. Open the SeaStar software. 
3. Plug a recorder to the PC computer. 
4. Select the 'File' menu and 'Recorder backup' command and the following window 

appears: 

Figure A.6 Select a Recorder *.RBD File 
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Browse for the correct RBD file on the computer and click OK. 
5. Insert the sequence number and remaining battery life (see figure A.7). Note that if 

the sequence number is set too low, data will be overwritten. 

Figure A.7 Set Sequence Number 

6. The SeaStar software downloads the RBD file into the recorder and the window in 
figure A.8 appears. Click OK. 

Figure A.8 Backup Operation 
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